Long before I machined and built my first air engine, I was building engines in 3D. As a mechanical CAD designer/engineer, I have always been intrigued by mechanisms and machines but never thought I would have the talent to machine and build anything myself. Anything I built was done on a CAD system, primarily in SolidWorks, a three-dimensional mechanical design software package. I worked as a CAD designer for a local machine shop in New Bedford, Massachusetts for about five years and worked with some exceptionally talented machinists.

One machinist, Garry Johnson, used to bring in his small stationary air engines each week and I found them fascinating. One day I asked if I could take one home to disassemble so I could model the parts in SolidWorks to create a three-dimensional assembly. The engine I chose was made mostly of see-through plastic, better known as clear acrylic. It took me a few hours to model each component and build a three-dimensional assembly. Using standard CAD techniques, I was able to operate the assembly in SolidWorks to see how the engine worked. Each week Garry would bring in a new engine and I would reverse engineer it and model it in SolidWorks. I had over two dozen engines modeled in SolidWorks, and then it became somewhat of a hobby for me to find engine plans to model.

I ended up finding what I think were the original plans for building that see-through engine and decided to make my own from my

![Image of a see-through engine model](image1)

CRANKSHAFT
mat1 - 1/4" steel dowel pin
SolidWorks models. Garry thought it was a good idea and offered to teach me. I took him up on the offer and chose to build an engine similar to “Lucy,” the see-through steam engine. This engine is a great first-time engine to build because of its size, small number of parts, and forgiveness of tolerance precision. In other words, you can make several mistakes and the engine will probably still run. I have built this engine about six times using different materials, shapes, and sizes, and every engine has run great.

The reason I put together this 3D engine build is to encourage newcomers to the hobby to build a nice, easy engine that has a lot of machining flexibility. Another reason is because a lot of the older, more experienced machinists are starting to design their own engines using a CAD system. I have never seen a CAD book use an air/steam engine as a learning tool and thought it would be a nice way for someone to get into the hobby...kind of the way I did.

I never physically build an engine until I build it in SolidWorks first. This 3D build was done using SolidWorks, but similar rules apply whether you are using SolidWorks or any other 3D CAD program. I have designed the instructions using a step-by-step process, adding only the necessary information to build the engine in 3D. A basic working knowledge of any CAD system is preferred but not absolutely necessary.

If you have access to a 3D CAD system I encourage you to give this engine a try. You have a lot of flexibility with the shape of the parts, material, and fasteners. If you are an experienced machinist, this engine may take you a few hours to build, but I suggest you try and design a new engine in a 3D CAD system. My 3D build steps can be applied to almost any part you decide to make, no matter if it’s simple or complicated. Once you start using 3D CAD to design and build engines you are not going to want to stop! 3D CAD is just another great tool we can add to the home shop machinist’s hobby toolbox.

**The Crankshaft and Crankpin - Details 1 and 2**

We will start with the crankshaft, which will be 1/4” diameter by 1-1/2” long steel; a basic part to make by using 1/4” round stock, saw cutting oversize, and facing to length *(Photo 1)*. (You can also use a standard 1/4” x 1-1/2” long dowel pin, as called out on the drawing.) The crankshaft ends up being an equally basic 3D modeling exercise as described in the next three steps.

The crankpin is simply a 1/8” diameter by 5/8” piece of steel. Like the crankshaft, a steel dowel can be used. The modeling sequence of the crankpin is identical to that of the crankshaft.
Modeling the Crankshaft

**Step One**

Start by selecting the right plane to create your first sketch (Screenshot 1). Any of the three default planes can be chosen (Top, Front, or Right) to create your first sketch, but the right plane was chosen because of the crankshaft orientation at final assembly.

Remember these three simple steps when building a model:

- Choose a plane to sketch on.
- Draw a sketch.
- Create a feature using the sketch.

These rules apply when using any 3D modeling software.

**Step Two**

Using the Circle tool from the Sketch toolbar, sketch a circle starting at the sketch Origin (Screenshot 2). Use the Smart Dimension tool to constrain the size of the circle to 1/4". Most CAD programs allow you to enter a value as a fraction and it will convert to decimal for you; in this case it is .250".

**Step Three**

Finish the sketch when complete and select the Extrude feature from the Features toolbar (Screenshot 3). We will now use the 1/4" diameter circle we sketched and extrude it to a length of 1-1/2". For the crankshaft we will extrude in only one direction using what is called a blind extrusion. As you can see, my extrusion is extruding to the right.

**Screenshot 4** shows the final 3D model of the crankshaft. One sketch and one feature were used to create this part. You can now add a material to the model, which in most cases adjusts its density, color, and texture based on the selected material. Some options that you can add to the model, like the Chamfer and Fillet feature, are shown in Screenshots 5 and 6 respectively.

The Piston – Detail 3

Next, we will focus on the piston, which will be made from 1/4" diameter by 2" long steel. This is another basic part to make by using 1/4" round stock, saw cutting oversize, and facing to length. You cannot use a standard 1/4" x 2" long dowel pin for this part because the dowel pin will be too hard to add a cross-drilled hole to. The 3D modeling intent for the piston is the same as the crankshaft except we need to add a 1/8" diameter cross-drilled hole for the crankpin.

This hole can be physically drilled using a standard 1/8" drill, which will provide us with the proper clearance if using a 1/8" hardened dowel as our crankpin (Photo 2). You can also use an
oversize 1/8” reamer for this step. Note that the circle is located 1/8” from the edge and the center is related horizontally with the sketch origin.

Modeling the Piston

Step One

After following the first three steps for modeling the crankshaft, we come to step one for the piston. Remember to extrude the piston to a length of 2” instead of 1-1/2” like the crankshaft. To add the 1/8”...
cross-drilled hole to the 3D model we need to first create a sketch on the front plane (Screenshot 7).

Remember the three simple rules when building a model:
• Choose a plane to sketch on.
• Draw a sketch.
• Create a feature using the sketch.

**Step Two**
Select the sketch from your feature tree and Extrude Cut the circle using the Through All selection for both Direction 1 and Direction 2. Since the front plane is cutting through the center of the piston we need to specify this double “Through All” direction in order to accomplish the task (Screenshot 8).

**Step Three**
Here is the finished piston (Screenshot 9). You can add chamfers and fillets to the ends of the piston if you like. You can also add a lead-in chamfer to the cross-drilled hole.

**The Crank Disk – Detail 4**
Next, we can build the crank disk, which will be 3/4” diameter by 3/16” thick steel when complete. The crank disk can be made
from a piece of 3/4” diameter stock faced and turned to a length of approximately 1/4” long, or as long as you need to clean up for your parting tool. Center drill, drill, and use a 1/4” reamer to achieve a close running fit on the crankshaft. Then use the lathe to part off the disk to the 3/16” thickness.

The last two steps are cross drilling for the 6-32 tapped hole for the setscrew and the 1/8” reamed hole for the crankpin as shown in Photo 3.

**Modeling the Crank Disk**

**Step One**

The first step in creating the crank disk is a simple sketch of a 3/4” diameter circle drawn on the right plane (Screenshot 10). We then extrude the circle using the Mid Plane option to a thickness of 3/16”. By doing this we are keeping the right plane centered in the middle of the part. This technique will allow you to add features to the outside diameter of the disk and keep those features centered. We will be adding a tapped hole to this model later on and the Mid Plane technique will become quite useful.

**Step Two**

Next we add the 1/4” diameter through hole for the crankshaft (Screenshot 11). Select the right surface of the part as your sketching plane and create a circle. Use the Extrude Cut feature to cut the hole using the Through All selection. If a hole or slot is cut through the entire part you should always use the Through All option. This is done so that if the part thickness is changed, the hole or slot will always cut through the part regardless of its thickness.

**Step Three**

Use the same method as in step two to add the crankpin hole. Using the same surface to sketch on, create a new sketch of a circle 1/8” in diameter and offset 1/4” (Screenshot 12). It is very important that the center of the crank disk is related horizontally with the center of the 1/8” hole. The Horizontal sketch relation is used to do this. This relation prevents the 1/8” hole from floating around and keeps it in-line as intended.

**Step Four**

These next few tasks are a bit tricky and may require some practice. We are now ready to add the 6-32 tapped hole to the outside diameter of the disk for our setscrew. We will be using the feature called Hole Wizard to do this.
Hole Wizard is going to require a starting location, or center point, of the hole. *Screenshot 13* shows what looks like crosshairs. This is actually a front view of the disk displaying the top plane and the right plane of the model. We used the Mid Plane option before because our intent was to have this tapped hole centered. We can now utilize the two default planes in our model to add an axis. Select Reference Geometry and then Axis from the list. Use the intersection of two planes as a selection and choose the two planes from the model tree or graphics area. SolidWorks will put an axis directly through the intersection of those two planes, which will be used to properly center our tapped hole.

**Step Five**

Using Hole Wizard, you will notice two tabs at the top of the menu. Under the Type tab, select the type of hole you want to add. In this case, we want to choose a 6-32 tapped hole (*Screenshot 14*). Once the type of hole is chosen you can click on the Position tab to locate the hole. Select the outside diameter of the disk as your first selection. Use the Point tool from the Sketch toolbar and add a coincident relation between the point and the axis we created.

*Screenshot 15* is a cross-section of the disk showing our results. If you cannot see the tapped hole displayed in your drawing as shown here, it may be your display settings. Turn All Annotations on in the View drop-down menu and then go to the Tools drop-down, Options, Document Properties, Detailing, and click the Cosmetic Threads and Shaded Cosmetic Threads checkboxes.

*Screenshot 16* shows what the finished crank disk should look like. Notice the crankpin is not shown because we have not modeled it yet! Normally, we would finish the disk, press fit in the crankpin, and be done. In 3D modeling we need to model the
Smithy CNC Machine Tools

**Talon CNC 1240 Mill** - This versatile mill matches the size of the popular Bridgeport mill. Built from the ground up for heavy CNC use, the 1240 is tough and solid. It also provides great accuracy and power.

**Talon CNC 622 Mill** - Designed for machinists that need a portable mill that meets true industrial standards, yet is small enough to fit through doors. Used in a wide variety of applications.

**Talon CNC 924 Lathe** - Built for general use applications with traditional bed design and carriage cross-slide with tailstock. Built to light industrial standards - a great portable second operations lathe. Fully featured and with full enclosure.

**EZ-Trol CNC Control System** - Easy to use interface and powerful software program - matches the power and functionality of well known industrial controls. State of the art hardware - seamlessly integrates with Smithy CNC tools.

**Granite Lathe/Mill/Drills with CNC Mod** - For over twenty years Smithy has set the standard for quality benchtop machine tools. Put a machine shop on your benchtop. Used in thousands of applications - Granite machines are guaranteed to pay their own way.

GET YOUR FREE INFORMATION KIT TODAY!
Call Us TOLL FREE 1-800-476-4849
(Dept DM)

Call TOLL FREE to Learn about:
- FREE Project Design Assistance
- FREE G-Code Programming Help
- Automating your machining projects
- Current Savings Offers
- Easy FINANCING PLAN

Check out www.smithy.com:
- Watch In-Action Videos
- Get Answers to Tech Questions
- View Specs & Features
- Learn about Industry Best Warranty
- Read Complete Pricing Details

**Smithy** Tools for Independent Craftsman

PO Box 1517 Ann Arbor, MI 48106-1517
www.smithy.com
Toll Free 1-800-476-4849 M-F 8-5 EST
pin and then create an assembly within the program to fit the two pieces together. Our finished crank disk will be an assembly of those two parts.

The Flywheel – Detail 5

The flywheel for this engine can be made from aluminum, brass, or steel (Photo 4). The overall size and shape will be 3” diameter by 1/2” thick. I added a recess to each side, as well as some holes to lighten it up towards the center. What I did not include in the modeling example is the tapped hole for a setscrew. I have added my setscrew on a slight angle, drilled and tapped toward the center of the flywheel. I have machined other flywheels with the tapped hole located on their outer faces as well. A 6-32 or 8-32 setscrew can be used.

Modeling the Flywheel

Step One

Start by sketching a 3” diameter circle on the front plane (Screenshot 17). In the same sketch, we can add the crank bore by drawing a 1/4” diameter circle. If both circles are started from the sketch origin they will be automatically constrained and require only the diameter dimensions.

Step Two

Use the Mid Plane option to extrude the flywheel to a thickness of 1/2” (Screenshot 18).

Step Three

Sketching on the front surface of the flywheel, we can add two more circles to simulate a cutout or face groove. I have chosen a 3/4” circle and a 2-1/4” circle respectively (Screenshot 19).

Step Four

Extrude Cut this finished sketch to a depth of 1/8” (Screenshot 20).

Step Five

This face groove can be duplicated on the opposite side of the flywheel by using the Mirror tool from the Feature’s toolbar (Screenshot 21). Select the front plane as your mirror plane and the Extrude Cut (face groove) as your “Feature to Mirror.”

Another option would be to sketch on the back surface of the flywheel and perform another
Extrude Cut the same as the first. Using the Mirror feature creates an association – what you do to one side, SolidWorks will do to the other. It creates a mirror image of your feature or sketch.

**Screenshot 22** is the flywheel shown with a full cross-section. It is now ready for a spoke pattern or standard hole pattern.

**Step Six**

**Screenshot 23** is a sketch containing a 3/8” diameter hole fixed to a 1-1/2” diameter bolt circle. The 1-1/2” diameter hole was changed to a construction circle because it will not be extruded or cut; it will be used for construction purposes only. I also added a vertical relation between the center of the 3/8” circle and the sketch origin.

**Step Seven**

An Extrude Cut using the Through All option works best here (**Screenshot 24**).

**Step Eight**

Last, I used a Circular Pattern to create the seven remaining holes as shown in **Screenshot 25**. The outer diameter circular edge was chosen as my circular parameter and the
feature to pattern is, of course, the 3/8" hole. I entered in a value of eight holes total and the program automatically divided 360° by 8 to place each angular increment.

**Step Nine**

The completed flywheel, with some added color to make it pop, is shown in Screen shot 26. Select any surface, then click the Edit drop-down menu, then Appearances, and change your color if desired.

**The Cylinder – Detail 6**

The cylinder is a straight milling job consisting of squaring up a 1-3/8" x 3/4" x 1/2" piece of clear acrylic. Any clear plastic will work if you want to see through the engine, or you can use a piece of brass instead. When machining this part, I have drilled and reamed the piston bore to suit the piston material. Often I have had to use a .001" oversize 1/4" diameter reamer and have had 100% success in running the engine.

I mark the approximate locations of where the pivot hole and air hole need to be. It is very easy to put this hole on the wrong end if you’re not paying attention (I have done this – twice!). A simple layout using a marker will help you avoid making any silly mistakes. The 3/32" air hole must have a crisp, sharp edge to avoid any input air leaking into the output hole or vice versa. The pivot hole can be drilled and tapped through to the cylinder hole, but this may let air escape, so use some Teflon tape if you plan on drilling through. In Photo 5 I have drilled and tapped a 10-32 UNF hole as far as I could without breaking through to the piston bore.

**Modeling the Cylinder**

**Step One**

First, I sketched a 1-3/8" x 1/2" rectangle on the Right plane and extruded this shape to a Mid Plane depth of 3/4" wide (Screenshot 27).

**Step Two**

Next, I used Hole Wizard to add the 1/4" diameter piston bore simply because Hole Wizard will give you the nice drill point seen at the end of the drilled hole.
A regular extruded cut would work here but it would not give you the drill point. A revolved cut would also work and give you the drill point but would require a work plane to sketch on. Hole Wizard should be used whenever a hole is being modeled; it is good modeling practice to do so.

Steps Three and Four

In Screenshot 29, you can see the finished cylinder with the 3/32" air hole and the 10-32 UNF pivot hole, both done using Hole Wizard.

In the next issue we will complete the engine project. We have one last component to make, the frame, and then can move on to the task of assembling the engine in CAD.